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OpenRoads Designer – Creating Cross Section Cut Sheets 

P-6-1: Creating Cross Section Sheets – Named Boundaries 

Return to Index 

Before you begin – Creating ORD Cross Section Cut Sheets - Video 

Additional processes for creating, row, environmental, existing point detail features, muck and rock surfaces and End Area 
Volumes are also covered here.  Information about the commands used can be found in File > Help > Help Contents.  When 
working with Cross Sections the Cross Section Navigator can help navigate the drawing models. 

Create Sheet Seed - Attach Reference Files – Display Information to be Sectioned 

Open ORD to the NHDOT Workspace and the project’s WorkSet.  Open/create the 12345-XSections.dgn. 

With the Default model active, attach all the dgn files that need to be sectioned over.  Survey, E-Terrain, E-Drainage, E-ENV, E-
ROW-Lines, E-Field-Check, E-Terrain-Rock, E-Utility, Geometry, P-Cor, P-Drainage, P-Utilities, P-Drives, Earthwork, P-
Guardrail-Platforms, P-ROW all with live nesting set to 0.  For Bridge Projects also attach the Brd-3D, P-Cor-Bridge, and P-Br-
Grading drawings.  While accepting through each drawing's attachment make sure you see the message that the Default-3D 
models are automatically being attached.  Shut off point features in the Survey file as those features are represented in the XS 
Detail drawings.  (only display the Survey.dgn then select By Element Cells – then right click off by element to shut off the levels 
- then turn references back on).   

View both the Default and Default-3D models by Right Clicking and holding to get the popup menu and select View Control > 
Views Plan/3D.  Set the Default-3D view active by clicking on the top of the view.  The content of the cross sections is 
determined by what is displayed in this View/Model.  Shut off Communication Nodes, Electrical Nodes, Gas and Water nodes.  
Update the view, Save Settings and Save the dgn.  This will be the Cross Section seed file. 

Create the XSection file by Copying the XS Seed 

Copy/Rename the seed to 12345-XSect-RoadName.dgn.  Add the RoadName.  With the Default view active, attach the 
appropriate 12345-XS-Detail-RoadName.dgn if generated.  Save Settings and Save the file, repeat for each road as needed. 

  

https://nhgov.sharepoint.com/:v:/r/sites/DOT-ProjectCentral-Home/CADD%20Document%20Library/nh-ord-p-6-1-create-cross-sections.mp4?csf=1&web=1&e=brEu25
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Create named Boundaries 

The cross sections are generated through Named Boundaries.  The cross 
section boundaries are 3D elements but get created in the Default view.  
Ensure you have 2 views open, a view of the Default (2D model) and the 
Default-3D model.  Set the active Level to be BDR-Named-Boundary.  With 
View 1 active, use the OpenRoads Modeling Workflow’s Drawing Production 
tab and select the Place Named Boundary tool.  Select the cross section image 
in the top of the tool.  Set the drawing seed from the dropdown.  This should fill 
in many of the properties in the tool box.  If a previous 
Group of sections were created, you can add to the 
group by selecting it from the group dropdown.  
Otherwise, you are being prompted to Identify a Path 
Element to create boundaries along.  The Name will 
take on the name of the Feature selected.  The offsets, 
interval and clearance(s), can be changed but are set 
for NHDOT standards.   

Check the Create Drawing and Show Dialog boxes then 
accept through them on the cursor prompts to create the 
Named Boundaries.  The Boundaries will be placed in 
both 2D and 3D views and the Create Drawing box will 
display. 

Create the Drawings 

The Create Drawing box is filled in per NHDOT standard 
setup.  The Default Annotation group is NH-
Preferences.  Decide whether to have the drawings 
added to the sheet index or not and hit OK to create the 
Cross Section drawings and sheet models.  The 
progress bar in the lower right will display your progress.  
Be Patient.  The last Cross Section sheet will be 
displayed when finished.  
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P 6-2: Basic Cross Section Annotation 

Introduction 

Line Work on the sections comes from the referenced 3D models.  Annotation on the sections is created in the cross section 
drawing models and comes from defined Annotation Groups which label the 3D elements referenced.  The referenced 3D 
models are always displayed in their latest state.  If changes were made to them, the Annotation for them needs to be updated.  
For elements newly created, the annotation group need to be used to annotate the elements.  For elements that have been 
changed or updated, the annotation needs to be removed and the features reannotated. 

When removing all annotation from the drawing models only annotation from the annotation groups is removed.  If elements 
were labeled using other tools, that annotation will remain in the Drawing models.  Annotation Labels that are copied into the 
drawing model are also not removed. 

Annotation Groups - Updating Cross Section Annotation After Changes 

Using the OpenRoads Modeling Workflow > Drawing Production tab > Annotations pane select the Model Annotation dropdown 
and select Remove Model Annotation.  Check the box for all drawing models and accept.  This will remove all annotation from 
the sections EXCEPT that which you have copied in or has been annotated by hand.  It will then be necessary to re-annotate the 
sections using the Annotation Groups.   

Annotation Definitions were created for each feature displayed on the cross sections.  These Definitions are organized into 
Groups to annotate like features.  The default NH-Preferences annotation group contains the Grid Definition as well as Existing 
feature labels and proposed slope and point definitions for the design corridors.  This is a great group to use through the design 
process.  Annotating sections can be time consuming so the groups can be used to only annotate what specifically has been 
created or changed. 

  Other groups are more specific to annotating information from specific reference files such as the NH E Detail and NH E Drn – 
Util, NH P Detail, and NH P Drn – Util Groups that annotate information developed later in the design process and only need to 
be annotated after those drawing are populated.   

Later in the plan development process some annotation can be copied into the Cross Section Drawing models so it does not get 
removed and need to be reannotated.  NH Anno Grid which only annotates the Grid and station values can be used and then a 
Batch Process run to copy that annotation into the drawing models.  The NH P Pref annotates proposed corridor points and 
crossing features. if any is present and finally the XS EAV Anno is for Cut and Fill quantities if they have been created.   
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Cross Section Existing Elevation Feature  

To annotate the existing elevations on the cross sections a linear feature needs to be 
created along the alignment.  Open the Geometry.dgn file and reference attach the 
terrain.dgn if not already attached.  Right click and use the View control dropdown to 
select 2 views Plan/3D. 

OpenRoads Modeling workflow > Geometry Tab > Horizontal pane Offsets and Tapers 
> Single Offset Entire Element   Set the Feature Definition to Linear > Design 
Features> Road > Sect ExistElev and then add the road name to the feature name ie. 
Sect ExistElev US Rte 4  Lock the offset to 0 and select the 
geometry element to create the new feature. 

Elevations need to be attached to the feature.  Select it by using 
element selector and clicking on the geometry and then right 
clicking to cycle thru until the Sect ExistElev feature is selected.  
In the Geometry tab’s Vertical pane select Profile Creation > 
Profile from Surface.  in the box set the feature definition again 
as well as update the name.  Lock the offsets and start and end 
range.  Left click to Apply DTM Profile and then select the terrain 
model by clicking on it.  Do not use the active terrain as you may 
loose the elevations if the terrain changes.   

Open the cross section file and reannote all the drawing models 
with NH-Preferences or NH P Pref for the elevations to display. 
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P-6-3: Controlling Displayed 3D information on the Cross Sections 

Introduction - Video 

The various reference files contain the base information that is displayed on the sections and the cross section annotation 
groups control what is annotated on the sections.  Other information from reference files is used to generate the End Area 
Volumes and the Volumes report for quantities but is not needed to be displayed on the finished cross section plots for the 
contractor.  It may be beneficial to create a Saved View of the display status so it can be used when annotation needs to be 
updated as well as one to globally shut the levels back off. 

Global Display 

Global display is used to turn off levels that you don’t want displayed on the cross sections.  Simply turning off the display of 
levels in the Default-3D model is not sufficient to turn them off in the actual sections.  The Global Display of levels can be 
achieved thru the Level Manager or thru the Level Display tools.   

Construction Plan Check List – for Cross Sections  

Review the Construction Plan check list for a list of what should be displayed on the sections.  Right click on the screen to open 
the View Control menu and select 2 Views Plan/3D.  This will display both Default and Default-3D models.  Make the Default-3D 
active.  Using the Level Display change the Type from View Display to Global Display.  Next shut off levels that don’t need to be 
displayed. 

Corridor and Drive dgn files can have their base courses shut off so only the Top and Bottom meshes are displayed.  The 
EarthWork.dgn can have all of its levels shut off.  All survey point features can be turned off.  In the XSections.dgn, all of the 
Volumes- levels can be turned off. 

 

When done updating the levels state, save Settings and then Save the dgn.  Create a Saved View for future use to recall the 
Global display settings if the annotation was redone and levels were turned back on.  To ensure that the changes make it to all 
the sheets it is suggested that the dgn is closed and reopened before printing. 

  

https://nhgov.sharepoint.com/:v:/r/sites/DOT-ProjectCentral-Home/CADD%20Document%20Library/nh-ord-p-6-3-control-3d-display.mp4?csf=1&web=1&e=MuoitV
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P-6-4: Cutting Additional Sections and Re-Sheeting 

Introduction - Video 

Cross sections can be added to the Named Boundaries group individually or through the use of Event Point Lists added to the 
Geometry Feature that the sections are cut from.  When adding new sections, the sheet models generally need to be deleted so 
the new drawing models can be inserted sequentially within the sheets. 

Create Event Point Lists to Create Additional Section Drawing Models 

Open the Geometry.dgn’s Default model and turn off the display of all reference files.  Next turn 
on the display of the Default model of the file that you wish to create extra sections for such as the 
Drives.  In the OpenRoads Modeling workflow Geometry Tab – Common Tools pane select the 
Event Point List tool and then select the alignment.  Click the New list button and name the 
Event Point List to create it.  Use help if you want to learn more about all the buttons on the list.  
Select the Add By Station Offset Button.  Unlock the Station value and 
then hit on the drive alignment at the intersection with the geometry.  This 
will add that station to the list.  Continue adding all Drive Stations.  

Create a new List for Existing Drainage.  You can use origin hit codes on 
the basins to locate where you want sections generated for them.   

Alternatively for proposed and existing drainage sections use a report to 
determine the station values needed rather than searching along the 
alignment and selecting the basins.  In the Default models turn off the Drives reference drawing and turn on the 2D display of all 
the Existing and\or Proposed Drainage (attach the Drawings if needed).  With the drainage displayed use element selector to 
select by Element Type – Cells.  This should select all Node Features.  In the General Tools Pane expand the Reports 
Dropdown and select Point Feature Station Offset Elevation Report.  It will prompt you to select the alignment and then Accept to 
bring up the report.  Format for Stationing ss+ss.ss if needed.  The report can be saved as a Word or Excel document as 
preferred.  Review the report and highlight locations that you want to add additional sections to be cut.  Only odd station CB, DI’s 
or Manhole locations that are within the cross sections offsets should be highlighted.   

Create a new Event Point List and use the Add By Station Offset Button to bring up the tool again.  Check the Station box and 
type in the station to be added from the highlighted report.  Accept the station to add it to the list.  Repeat for all additional 
locations needed.  Repeat for Proposed Drainage locations if desired with a separate Event Point List. 

https://nhgov.sharepoint.com/:v:/r/sites/DOT-ProjectCentral-Home/CADD%20Document%20Library/nh-ord-p-6-4-cut-additional-sections-resheet.mp4?csf=1&web=1&e=R0HHPH
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Create Named Boundaries for the Additional Sections 

Open the Cross Section Drawing.  Open two views, Default and Default-3D.  Set the BDR-Named-Boundary level active in the 
Default model.  In the Drawing Production tab open the Named Boundary tool.   

 

Set the Drawing seed, Scale and Group to match the previous sections settings.  ** NOTE IT IS IMPORTANT TO SELECT THE 
GROUP rather than New.  Sections can not be moved from group to group after they are created. 

Identify the path element by selecting the alignment.  The mouse will be tracking along the alignment, be careful to not click on 
the screen.  At the bottom of the input boxes, select the Event Point List that you want to create additional sections for and then 
check the box to Include Event Points Only.  Left Click on the screen to accept your selection and create the named boundaries. 

Next the Create Drawing box will open if Create Drawing was checked on in the Place Named Boundary tool.  Un-Check the 
Create Sheet Model section so only Drawing models are created at this time.  Set the Annotation Group to NH Anno Grid and 
Click OK to create the Drawing models.  The drawing models could be created from the Named Boundaries tool box as well. 

Delete old Sheet models and Re-Sheet the Sections 

Open the Models Tool from the Home tab or hover over it if it is docked to get it to 
expand.  Select the sheet models and delete them as they need to be recreated.  
(Shift Click to highlight multiple models)  Do not delete the gray Drawing models. 

Open the (Manage) Named Boundaries tool box.  Expand the Cross Section Groups 
and review the group’s stations make sure there are no duplicates.  Select and delete 
if there are.  If the drawing models were not created in the previous step, you would 
need to select only those boundaries in the list and then use the Create Drawing tool 
in the top to create them. 

Back in the Named Boundaries tool – Right Click on the Group name and select 
Create Cross Section Sheets from Drawings.  
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Modify Special Station Sections for Drainage 

For cross sections cut with proposed drainage running longitudaly along the roadway  

P-6-5: Create Features of ENV and ROW Elements 

Return to Index 

Before you begin - Video 

This process can take place once you have an existing terrain model as well as delineated wetlands or existing row lines drawn.  
The intent of this process is to featurize and assign elevations to elements that need to be labeled on the cross sections.  When 
the features are created and attached as a reference file to the cross sections they can then be annotated with the NH E Detail 
or NH-Preferences annotation groups. 

Attach Reference Files 

Open/Create the drawing to be worked on, the 12345-E-ENV, E-ROW-Lines or P-ROW. 

Next, Reference File Attach the drawing containing the MicroStation elements to be featurized.  Live nesting should be set to 0 
when attaching the env, erl, or prw files from the Prj directory.  Next, Turn on all levels that are good and in the Reference file 
Dialog box select the reference file.  Use Tools > Merge into Master and then click in the view to copy all the elements 
displayed into the dgn and automatically detach the dgn reference file. 

View both the Default and Default-3D models by Right Clicking and holding to get the popup menu and select View Control > 
Views Plan/3D.  Set the Default view active by clicking on the top of the view.  Reference file attach the Combined.dgn with Live 
Nesting set to 1.  Fit View. 

 

Save Settings and Save the dgn.  Use File > Open to re-open the dgn.  This will make some of the 3D elements from the 
attached reference files visible in the Default view that were previously not displayed.  Make sure the terrain model is visible as it 
will need to be identified as the source of the profile elevations. 

  

https://nhgov.sharepoint.com/:v:/r/sites/DOT-ProjectCentral-Home/CADD%20Document%20Library/nh-ord-p-6-5-create-annotate-linear-features.mp4?csf=1&web=1&e=pDRxHR
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Create Features from Elements 

1. Use element selector and select all elements in the drawing by clicking on Select All.  
Expand the extended settings by clicking on the triangle at the right if not already 
expanded, use the level tab to display levels with elements in them.  Next unselect all but 
one level.  Start with isolating the top level first and progress through each in turn.  

2. In the Feature Definition toggle bar set 
the Use Active Feature button on the 
left and select the linear feature 
definition for the elements selected.  
Use the Create Civil Rule Feature 
tool from OpenRoads Modeling 
workflow, Geometry tab’s, General 
Tools, Design Elements, drop down 
menu.  

3. Data point in 
the view to 
create the 
features.  

 

 

 

4. With the features still selected use the Profile From Surface tool in the Vertical group of 
the Geometry tools to attach elevations to the new features.  Data point on the screen to 
Profile the selected elements.  Next, Select the Existing terrain model by clicking on it. 
(do not right click to use active terrain model as this can cause problems when the 
features are imported and no terrain is active).  Accept through the rest of the prompts as 
displayed to the right to attach elevations to the features.  

Repeat steps 1 – 4 on each level containing elements.  If a feature definition cannot be found for 
selected elements that means it is not something that is normally show on the sections does not 
need to be featurized.  Repeat for each ROW and ENV file. 

When finished Annotate All Drawing models using the NH E Detail or NH-Preferences groups.  
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P-6-6: XS Detail Tick Features for Section Annotation 

Introduction – Video Playlist 

Cross section detail tick features are created from point features that are deemed relevant to appear on the 
cross sections.  They include trees, poles, hydrants and such.  A point feature station offset elevation 
report is run on the 12345-Survey.dgn’s point features as well as an alignment xyz report to get the 
information for a macro which draws tick mark elements at the 50-foot stations.  These tick marks are 
featurized and profiled over the terrain model to assign elevations.  A separate dgn should be created for 
each Alignment for the tick features to be included in the XS drawing for that Alignment. 

DGN setup - Video 

Open the 12345-XS-Detail.dgn's Default model.  Check that the Combined.dgn is attached with live nesting 
1 to see the project’s existing detail drawings.  Reference File Attach the 12345-Geometry.dgn file (no 
nesting) as well as the ….\OpenRoads\Survey\12345-E-MX-Survey-Topo.dgn that contains the point 
features.  Save settings, Save the dgn and reopen it.  Set the existing terrain model Active. 

Using only the Default model view, shut off all reference files that don’t have point features, except the 12345-Geometry.dgn's 
Default Model.  Also shut off the Default-3D model reference.  The view should now only show the Geometry and the E-MX-
Survey-Topo Default models.  Save Settings and Save the dgn.  This file will be the Seed detail file.  Continue by Copying/Save 
As this file as 12345-XS-Detail-RoadName.dgn 

Create Alignment Report 

If a 50' interval alignment report in .XLS format already exists, skip this section and continue 
to create the detail station & offset report.  Select the Horizontal Geometry Report button that 
is found on either the Analysis & Reporting or the Horizontal Geometry Task menus. 

Follow the Heads-Up prompt and select the alignment (in the Default View) associated with 
the cross sections you wish to annotate.  Click the Right Mouse (Reset) button to complete 
the selection process. 

Confirm that the boxes on the Horizontal Geometry Reports panel for Lock to Start, Lock to 
End and Interval are all checked.  Set the Interval value to 50. 

https://nhgov-my.sharepoint.com/personal/eric_d_milliken_dot_nh_gov/Lists/P66%20Create%20Cross%20Section%20Detail%20Ticks?env=WebViewList&viewid=e24a4583%2D568f%2D4ec9%2Da11e%2De53bb83ae03d&playlistLayout=playback&itemId=4
https://nhgov.sharepoint.com/:v:/r/sites/DOT-ProjectCentral-Home/CADD%20Document%20Library/nh-ord-p-6-6-a-create-detail-ticks.mp4?csf=1&web=1&e=9CNJxo
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If the alignment does not start at an even 50 foot value, uncheck the Lock to Start box and enter a start station that is at an even 
50 foot value. 

The last prompt looks for Profile information.  This report does not need to have vertical information, so any response for this 
prompt will suffice.  If there is interest in other reports beyond the scope of this procedure, then specify Active Profile so that the 
vertical component is included. 

OpenRoads will open the Bentley Civil Report Browser and display the default horizontal report.  This browser offers many 
predefined report options on the left side of the panel.  The right side of this panel displays the output of the selected report 
option.  From the left side of the report window, select the HorizontalAlignmentIntervalXYZ.xsl report. 

The report must have the correct station format before saving.  Tools > Format options > Stations should be set to SS+SS.SS   
Direction should be ddd^mm^ss.  When the report is displayed, select Save As... from the File menu and select the Microsoft 
Excel option.  Provide a file name.   

Create Station/Offset Detail Report 

In the Default model turn off all reference files then turn on only the survey reference.  Use Element selector and drag a box 
around all the survey features to be reported in the project area to select them.  In the Properties box select the Cells entry and 
then right click Select to select only the cells.  Note that only features which typically appear on cross sections will be processed.  

Once the point features are selected, turn on the display of the geometry.dgn.  then choose the Point Feature Station Offset 
Elevation Report tool from the OpenRoads Modeling workflow - Model Analysis & Reporting tab - Reports dropdown. You will be 
prompted to click on the alignment (select it in the Default view) and then data point to accept the selected detail features. When 
the default report appears, change the report to ***IMPORTANT*** at the bottom of the reports list expand Reports > and select 
the NHSurveyStationOffsetNorthingEastingElevationFeature.xsl. Use the Save As option on the File menu of the report 
window to save this report as an Excel (*.xlsx) file.  Open the report to check its contents.  If you use the default Station Offset 
Northing Easting Elevation Feature Report from the StationOffset section the report file will 
not work with the macro. 

Create Cross-Section Detail Features 

Once the reports are created, the next step is to create a series of lines at the even 50' station 
which is nearest to each detail feature. If not already, Open the 12345-XS-Detail-
roadname.dgn, Default model that was created to contain these detail lines.  Creating 
separate drawings for each alignment's detail ticks (by using the File > Save As command). 
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To create cross section detail features in OpenRoads Designer, set the workflow to Drawing > Utilities tab > Macros pane select 
XSDetail macro from the drop-down menu then click Play. Select the detail and alignment xlsx files created in the previous steps.  
Click Apply if you plan to do another alignment after or OK if this will be the only one processed.  The macro creates short line 
segments offset at each 50-foot station.   

 

1. Use Element Selector to select everything in the drawing.  Switch to the Element 
Templates tab of the element selector.  Click (or click and drag) on each to deselect 
all templates except one, leaving only it selected.  

2. Next use the Feature Definition Toggle bar drop down list, expand Linear > XS Detail 
> and set the feature to match the selection and turn on the Use Active Feature 
toggle button. 

3. Use the Create Civil Rule Feature tool from the 
Geometry tab’s General Tools pane > Design 
Elements dropdown list to set the feature definition 
and Accept.  The selected lines should now be 
features of the type that is active. 

4. The features are in the Default model.  In order for 
them to show up on the cross sections, they will 
need elevations.  Use the Geometry tab’s Vertical 
pane’s Profile Creation dropdown tool Profile 
from Surface to attach elevations to the features.  
Make sure the feature definition is still defined and 
the elements still selected from the previous step.  Accept through the 
prompts and Right click to use the active Terrain model when asked.   
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The names of the features can be 
annotated on the cross sections. 
Attach the 12345etxt.dgn for tree 
sizes and descriptions.  The Point 
Feature Station Offset Elevation 
Report created earlier will provide 
the + station of the features.  
VIDEO 

Use Element Selector to select 
each tick and edit the name in 
Element Information to include the 
+ station value for all features.  
Pole numbers, tree sizes and 
descriptions are not required on 
the sections.  For Poles, add a L or 
an R to the +station to indicate 
Leave and Removal.  For 
proposed Poles, annotate P +XX 
or T +xx.  If you have duplicate 
pole + stations add spaces to the 
end to make them different.  Could 
add decimal. 

Selecting the Feature in the 
Default-3D model or bringing up 
the profile of it allows the profile to 
be modified (vertical offset) moving 
it up or down based on the +sta of the feature. Video 

Add the XS Detail Road name drawing as a reference file to the Xsections and Annotate the detail using the appropriate 
annotation group, NH E Detail or NH P Detail.  If changes to the +sta name or profile elevation are made the annotation needs to 
be removed and then reannotated. Video 

 

  

https://nhgov.sharepoint.com/:v:/r/sites/DOT-ProjectCentral-Home/CADD%20Document%20Library/nh-ord-p-6-6-b-name-ticks.mp4?csf=1&web=1&e=HuMEtH
https://nhgov.sharepoint.com/:v:/r/sites/DOT-ProjectCentral-Home/CADD%20Document%20Library/nh-ord-p-6-6-d-move-detail-annotation.mp4?csf=1&web=1&e=3QgsMC
https://nhgov.sharepoint.com/:v:/r/sites/DOT-ProjectCentral-Home/CADD%20Document%20Library/nh-ord-p-6-6-c-annotate-detail.mp4?csf=1&web=1&e=ZuCqZ0
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P-6-7: Skewed Drive Sections (and Profiles) 

Introduction – Video Play List 

Creating skewed drive sections is a process that includes creating horizontal and vertical geometry, adding extra named 
boundaries to create sections as well as displaying and referencing the skewed drive profiles into those sections.  The process 
can be done by adding the additional sections into the main group or by creating a new group of just the drives. 

Open the Drives.dgn’s Default model and reference the Combined.dgn with live nesting 1, the Geometry and Corridor dgns with 
no nesting.  Adjust Level Display so that no Default-3D Levels or Models are displayed other than the Terrain’s.   

Create the Drive’s Horizontal Geometry 

Skewed Drives should be created by elements with a tangent perpendicular from the Mainline alignment out to the P_EP and 
then skewing along the drive. 

Use the OpenRoads Modeling Workflow Geometry Tab Horizontal > Geometry Pane > Place Line Between Points command.  
Use Feature Definition Alignment Elements.  Select 2 points along the CL of the drive in the skewed area.  Use the Trim to 
Element command to extend this line back to the Corridor’s EP.  Place Line Between Points and set the snap mode to 
Perpendicular.  Select the Mainline alignment and slide the tangent back and forth ensuring it’s perpendicular and then snap to 
the skewed line’s endpoint on the EP. 

In the feature definition Toggle bar set Alignment Drive and use the Create Complex tool to join the pieces and create the 
connected drive geometry.  If the drive is in a cut section a reference line (Feature = Construction Control) 7’ over at the slope of 
the shoulder from the EP can be created using the Single Offset partial command and then the Profile by Slope from Element.  
Rename the created drive feature adding the approximate station and side for identification purposes. 

Create the Drive’s Vertical Geometry 

Right Click in the Default view and hold until the pop-up menu displays.  Move into the View Control menu and select Views 
Plan/ Profile/3D.  OK.  When asked, hit on the Drive alignment in the Default view then the bottom view to display the profile in it.  
In View Attributes the view’s Exaggeration can be modified from the default of 10 to 1 so the profile looks more like a section for 
easier viewing.  

In the Profile View, Select Create 3D Cut. Full and click in the profile view to display the cut of the 3D model. Snaps will be 
turned off in the referenced Cut graphics.  In Level Display Select and right click on the referenced Drive’s Default-3D model and 

https://nhgov.sharepoint.com/sites/DOT-CADD-Team/Lists/Skewed%20Drive%20Creation%20Playlist/AllItems.aspx?env=WebViewList&viewid=dd93c0ff%2D1085%2D4d83%2D81d4%2D20ea7d3d8e4f&playlistLayout=playback&itemId=5
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turn Snaps on by checking it.  From the Profile Creation menu select the Profile Intersection Point command.  Select the Drive 
and then the Edge of Pavement element and a point should appear on the profile at the location of the feature showing the 
location of the drive’s intersection elevation point. 

Set the Feature Definition to Elements Alignment again and create the drive profile from elements starting with Lines.  The 
drive profile should start at the EP of the corridor using an Origin Point snap on the intersection point.  Back in the profile view 
select the Line command again and you should be able to snap to Corridor’s EP.  If the drive is in a cut, define the second point 
using an Origin Snap selecting the Construction Control cell that was placed or set the length and slope to the next point.  
Adjacent Drive Slopes should not exceed a 10% algebraic difference in grades of lengths not less than 10’ generally.  Place the 
next line from the previous one with a Key Point snap at its end and set the length and slope of the next tangent.  Use the Right 
arrow key to switch between them and lock the entries by hitting the Enter key.  Continue until the profile matches in, the last 
tangent section can be Trimmed to Element to meet the existing ground.  Change the Feature Definition to Alignment Drive and 
use Complex Geometry by Elements to link the pieces together.  Select the connected profile and set it active.  The drive should 
now be displayed in the 3D view.  
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Create Drive Profile Drawing for Xsection 
Reference 

Review the cross section that was cut at the Drive 
location and determine the height of the section as well 
as the Top Clearance used. 

With the drive’s profile view active, use OpenRoads 
Modeling workflow > tab Drawing Production, then 
Select the Place Named Boundary tool.   

• Drawing seed (none), Detail Scale 1”=10’ 

• the profile should be named for its mainline 
station value and side.   

• Start station set to 0. 

• Stop location set to 1+00 for 10 scale sections set 
vertical. 

• Vertical Exaggeration to 1 

• Top Clearance to match the sections (typically 
14). 

• Available Profile Height can be limited to 40’.   
Accept through the prompts to create the named 
boundary and bring up the create drawing box. 

Fill in the Create Drawing box as shown.  Click OK when 
done to create the drawing. 

Save Settings and Save. 

Open the Drawing model just created and shut off all the levels in the active model 
leaving the levels from the reference file turned on.  Plot a skewed drive cell. 
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Place a Drive Civil Cell and Manipulate It 

After placing the drive civil cell, click on Create 3D Cut to display the driveways select materials in the profile view. 

Create a Station Offset Report from the Mainline Alignment to each Drive 

Set the workflow to OpenRoads Modeling > Home tab > Model Analysis pane, select Reports > Station Offset Report.  Select the 
roadway alignment and then click on each driveway alignment Reset to complete and have the report show up.  Save this report.  
Each drive’s profile can also be reported on and saved. 

Open Cross Sections drawing model and reference in the Drive Profile 

Open the Cross Section dgn file and then open the drawing model associated to the drive section.  Reference file Attach the 
drive profile with live nesting 99.  Proposed and existing levels can be turned off for the actual section which may not follow the 
drives skew.  This information can be clipped out of the sections drawing models reference file.  Also shut off the drives profile 
elevations.  
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P-6-8: Cross Section Earthwork Features 

Creating Cross Section Earthwork Features 

Cross Section Earthwork features include Topsoil, Pavement Removal, Unsuitable Materials as well as Limited Reuse Soils 
which are delimited with a 2D outline that is used to create clipped terrain models.  The depths will be created with surface 
templates. Muck and Rock will also fall into this category but are dealt with somewhat differently. 

 

This information will be stored in the 12345-Earthwork.dgn. Note that references to "12345" in file names refer to the project's 
five-digit Project Number. 

 

Create Earthwork Feature Boundaries 

First, the area to be computed needs to be delineated as a closed 2D shape.  Set the level to the feature you are going to 
delineate. The level names are Strata - followed by the type. 

Use the Fill Area Boundary created previously and any other elements to create closed areas/shapes for the features needed.  
For example, use Element Selector and select the Fill boundary, drive edges and the existing edge of pavement. 

Use the Create Region tool to delineate Topsoil removal areas. Set the fill type to Flood (the left most icon at the top of the 
panel) and check the box to Keep Original. 

To define areas of pavement to be removed, a color plan or the hearing plan can be attached as a reference. The Fill area 
boundary and the edge of pavement features can be used to determine the area of pavement to be removed. 

After all the shapes are defined, use the Terrain Modeling task Create Clipped Terrain Model to create a separate clipped terrain 
model for each area.  Use the NH_Prop_Earthwork Feature Definition under the Terrain Display features and set the Feature 
Name to reflect the area and location as shown below. 
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Apply Surface Template 

A Surface Template needs to be applied to each clipped terrain to define the material and depth.  See the chart below.  If a 
different depth of material is needed Open the template editor, Copy the desired template, rename it and re-specify the depths 
below the origin. 

Topsoil removal depth and any unsuitable material should be defined in the geotechnical report.  Existing pavement depths may 
be found in the pavement recommendation or from the borings or straight-line diagrams. Areas of differing depths should be 
defined separately and a different depth template assigned.  Drives usually only have 2 or 3 inches of pavement vs. the roadway 
possibly having 5 or more. 

 

Earthwork Summary Sheet Description 

Terrain Name * 

Template Name 

2A Bituminous Pavement in Fill Sections Earth - Pavement x" Exist Pave 

8 Topsoil Removed Beneath Fill Sections Earth - Topsoil x" Topsoil 

9 Unsuitable Material Removed Beneath Fill Sections Earth - Unsuitable x" Unsuitable 

Limited Reuse Soils LRS Earth - LRS Unsuitable 18" LRS Unsuitable 

* A description can be added to clarify areas.  For example, 

Earth - Pavement - LT Sta 21+00 - 22+25 

 

End Area Volumes 

Cut and fill volumes are created in the Cross Section dgn.  Workflow OpenRoads 
Modeling > Home tab Model Analysis and Reporting pane >  select Civil Analysis 
dropdown Create Cut and Fill Volumes.  Next Use the Create End Area Volumes 
report tool from the dropdown.  The Volumes report can be saved for quantity 
calculations.  The EAV boxes are added by selecting Model Annotation from the Drawing 
production tab and selecting the XS EAV Anno C-F group.  A different group, XS EAV 
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Anno C-F-R-M can be used if Muck and or Rock is present on the sections.  Check the All Drawing Models box. 

To Remove just the End Area Volumes annotation a Batch Process can be run with command file cmdfile-XS-anno-delete-
EAV-levels.txt to delete the XS-Volume-Annotation level from all the drawing models prior to reannotating. 

 

Entries for Rock or Muck removal can be found in the Volumes Report.  They are not automatically filled into the annotation box 
and must be edited by hand. 
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P-6-9: Rock Excavation Quantities 

Introduction 

A set of 25’ sections is created and sent to Materials & Research for Rock line interpolation.  Sheets are returned to design and 
scanned.  Lines are drawn in plan view at each section location and the profile displayed.  The scanned files are referenced into 
each Profile View of the section location traced and set active.  Create a terrain model from all sections.  Then apply a surface 
template. 

Create Sections for Materials & Research 

Coordinate with the Bureau of Materials and Research to determine station and offset limits needed.  Follow the directions at the 
start of the create cross sections to create a set of sections in the ROCK area at 25-foot increments.  May need to create 
Landscape sections with wider Left or Right offsets to accommodate the Rock Lines. 

Create Rock Terrain 

Create Event Point List and Create additional 25 foot Sections 

From the Materials and Research sections determine where Rock may be impacted to determine where additional Sections are 
needed to cover the impacts.  If it is early enough in the project and there is not much hand annotation on the sections just recut 
all the sections for the roadway with 50 foot increments before and after the area that 25 foot sections are needed.  Add at least 
2 additional 25 foor sections beyond the length of impacts.  If the project has a lot of modified/hand annotated information create 
a new Event Point List on the Geometry Feature with only the +25 and +75 foot stations.  Use the Event Point List to create the 
additional sections and annotate as needed.  Either individually or by running the macro and batch routines described above. 

Create/Apply Earthwork Surface Template 

After the Rock terrain model has been created, review the Dynamic sections 
to determine the greatest depth of rock removal.  Create a new Surface 
template with the components vertical depth that is greater than the largest 
rock removal depth.  Set the Feature definition to Mesh\XS 

https://nhgov.sharepoint.com/sites/DOT-ProjectCentral-Home/SitePages/Create-Rock-Surface-from-Sections.aspx
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Components\Strata – Rock.  This Feature definition should have the Volume Option set to Substrata. 

In the Earthwork.dgn file’s Default model reference in the Rock Terrain.dgn.  Open the Default-3D model.  

OpenRoads Modeling workflow > Model Detailing Tab > Create Closed Mesh tool to create a mesh for rock calculations to be 
done on. 

In the XSections.dgn file attach the Earthwork dgn and Rock Terrain.dgn files.  The Civil analysis tool Compute cut and fill 
volumes is used.  When it finishes, use the Create End Area Volume Report.  The report will show the total Rock which can be 
ignored…. As well as the Strata-Rock (Removed) which is what you want to annotate onto the sections EAV table cell. 

 

Label Rock and Muck Lines 

To annotate rock and muck lines on the sections features need to be created and draped on their 
terrain models.  The lines can be created in the Rock or Muck terrain dgn files.  In the Feature 
definition toggle bar set the feature definition (and check use active) to Rock or Muck Line Label. In 
the Default model reference the Geometry dgn file.   

• Use geometry tasks Offsets and Tapers > Single Offset Entire Element and select the Road 
centerline.  Offset the feature so that it will be over the terrain model where you want the labels 
to appear in the sections.  The geometry can be tapered or at different offsets along the 
project if needed by creating as Complex Geometry by PI.   

• Use Profile From Surface tool in the Vertical group of the Geometry tools to attach elevations 
to the new feature.  Data point on the screen to Profile the selected elements, next Select the 
Rock or Muck terrain model by clicking on it. (do not right click to use active terrain model 
as this can cause problems if no terrain is active).  Accept through the rest of the prompts as 
displayed to the right to attach elevations to the features.  

The Rock and Muck annotation entries are part of the NH E Drn – Util Annotation Group.  The levels 
can be deleted using a batch process with cmdfile-XS-anno-delete-E-DrnN-Util-levels.txt as the command file and then 
reannotated.  Alternately a new Group can be created with just the 2 entries XS txt Rock Line and XS txt Muck Line.  
Understand that the levels they use are the same for the other NH E Drn – Util items. 
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P-6-10: Advanced Annotation Techniques for Final Sections 

Introduction 

.  So, for information such as the Grid and station values that will not change, copying them into the drawing model will speed up 
removing and reannotating time as they would not need to be reannotated in the future.  Batch process routines and macros are 
being created to assist in removing and reannotating annotation groups other than the Grids that will specifically delete the 
annotation levels of specific Annotation Groups to minimize annotation time and rework to any modified annotations that are 
copied.  

 

Alternately, a macros Update_XS_Anno will remove all annotations and reannotate all of the groups, but can take quite a bit of 
time to run.  

After selecting a group and accepting the command, a box showing the Annotate Progress Form will appear.  Move your cursor 
into the box to keep it on top so you can see the progress.  If it gets hidden and you start the next command, it may crash or not 
finish annotating the sections. 

 

Copy the Base Grid Annotation into Each Drawing Model 

To Speed up future annotation processes, remove all annotation and then annotate all using the NH Anno Grid Annotation 
Group the drawings.  Next copy all the information that was annotated from the group into the drawing models so it does not 
need to be reannotated in the future.  Open the First Drawing model using Element Selector > Select All then Copy from and 
to the same point.  Repeat for each drawing model.   

This can be done with a Batch process.  File > Tools > Batch Process.  Add the Cross Section 
dgn to the Batch process tool and set to all models.  Select the command file cmdfile-XS-anno-
Copy-E-Grid-levels.txt and then process.  This selects all the NH Anno Grid 
levels and copies them in each model.  When finished open a drawing model 
and remove all annotation from all.  The levels copied are shown in the 
graphic to the right.  Another command file exists to delete the specific levels 
cmdfile-XS-anno-Delete-E-Grid-levels.txt if there are issues and they need 
to be recreated. 
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Review and add Additional Annotation 

In the previous steps the NH Anno Grid Annotation Group was used to annotate the drawings, and then copied into the drawing 
models.  Additional annotation groups label the NH E Detail, NH E Drn – Util, NH P Drn – Util, and NH P Detail.  These groups 
can be used as those types of features are generated.  The macro Update_XS_Anno will remove all annotations and reannotate 
all of these at once.   

 

 

 

 

If an annotation group is used and deemed to not need updating in the future such as the NH E Detail or NH E Drn – Util those 
levels could also be copied into the drawing model after they are annotated.  They would then not need to be removed and 
reannotated so any changes to them would not be lost.   

Batch command files exist for Copying or Deleting the levels associated to each annotation group.  They actually take longer to 
process but once the groups levels are copied they would not need to be annotated again speeding up time in the future. 

• cmdfile-XS-anno-Copy-All-level.txt 

• cmdfile-XS-anno-Copy-E-Detail-levels.txt 

• cmdfile-XS-anno-Copy-E-Grid-levels.txt 

• cmdfile-XS-anno-Delete-EAV-levels.txt 

• cmdfile-XS-anno-Delete-E-Grid-levels.txt 

• cmdfile-XS-anno-Delete-E-Detail-levels 

• cmdfile-XS-anno-Delete-E-DrnN-Util-levels.txt 

• cmdfile-XS-anno-Delete-P-DrnN-Util-levels.txt 

• cmdfile-XS-anno-Delete-P-Pref-levels.txt 

• cmdfile-XS-anno-update.txt 
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Batch Process  

For roadways with multiple section drawings, a batch 
process can be run to update all the drawings.  File > Tools 
> Batch Process.  Add the files to be processed.  Select the 
command file cmdfile-XS-anno-update.txt.  This file has 
the macro play Update_XS_Anno command in it.   

In the Process Tasks area select each cross section file that 
you added and change the model to be processed to one of 
the cross section’s Drawing models contained in the dgn.  
Save the Batch Process and then Process Batch Process 
Job.  Move the Process box out of the way and click. 
Process  The Batch process will open each dgn to the 
drawing model selected and then run the macro to 
reannotate all the drawing models. 
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Editing Annotation Groups - Changing Top Frame Annotations 

The cross sections are set up to annotate a list of features contained in the annotation groups.  When used, an annotation group 
and its entries are copied into the dgn.  To edit the list or update to the latest settings, make the Default View active.  Open the 
Explorer’s OpenRoads Standards Tab, Expand Standards and then select the drawing name.  Right click on it, then select 
Update Standards From dgnlib.  This will update the Annotation Group entries to the latest definitions.  (may not want to do this if 
you have already edited your group for your project as this will reset the standard named groups and entries to match the dgnlib) 

Next, open the Annotation Group and modify the point annotation list.  Expand the > Drawing Name > Annotation Groups > 
Cross Sections > Drawing > NH P Pref.  Right Click and select Manage.   Alternately select the annotation group and in the 
Properties pane select the Annotation List and click on the … button.  This will bring up the annotation Group for editing.  The 
entry for XS Top Frame controls the list of points that are annotated with offset and elevation across the top of the section.  
Select XS Top Frame.  This will display Row list and Row Properties which shows the Location list of points to be annotated.  
Click on the Add filter button above the Expression to alter the list. 
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Highlight an entry and then click on Remove to remove it from the list or Scroll to the Bottom of the list and click in the blank box 
to add a new entry.  As a minimum the Road Trav Way, Shldr Edge of Pave, Slope Ditch Front and Toe features should be 
labeled.  All others could be removed depending on the Template used.  When done, click Apply Expression Changes to save 
the list then the X to close the box.  After editing the Offset Row the Z or elevation list should be edited to match the same point 
list entries. 

The Annotation Group Entries can be used in more than one group.  If you update the XS Top Frame point list in the NH-
Preferences group it will be reflected in any other groups such as the NH P Pref group. 

The Row Properties can be edited by clicking in the Expression area, highlight an entry and delete it.  Repeat for both the offset 
and Z to keep them the same.  Pay attention to the syntax if you do it this way.  When Editing via the Filter expression make sure 
each entry it set to OR…. or the entry won’t annotate because it is not X AND Y its only one thing. 
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Editing Annotation Groups – Changing Slope Annotation Segments 

As above, to edit the Annotation Group in Explorer, Expand the > Drawing 
Name > Annotation Groups > Cross Sections > Drawing > NH P Pref (or NH-
Preferences).  Right Click and select Manage.  There are 2 entries for Slope 
annotation, XS Left (& Right) Slope Annotation.  Select one of them and then 
click in the Location box followed by the … button that appears.  The 3 
expressions control the selection of points confining them to top line points on 
the left or right side of the CL.  These should not need to be modified.  At the 
top is a dropdown set to > Create list of segments.  The list of segments is at 
the bottom of the box and can be changed by clicking on the box to the right 
Select Segments from Template.   

At the top of the Select Segments box - use the dropdown to select a template.  
This will fill in the list of available points and segments in the left.  Entries in the 
bottom left can be selected and then using the arrow will copy them to the right 
list of segments to be annotated.  Alternately, the Point 1 and Point 2 can be 
selected from the dropdown lists and the green + will add the 
segment to the list.  

Different Templates can be used to seed the point list so the 
segment list can be created for a variety of Templates.   

 

 

Close the Select Segments box when done and then Apply 
Expression Changes and close the filter to save it. 

 

 

Remember to open a section Drawing model, Remove the model annotation and then Reannotate all the sections to see the 
changes you made to the Group.  A Batch Process with command file cmdfile-XS-anno-delete-P-Pref-levels.txt similar to the 
one above can be used to delete only the levels annotated with the NH P Pref Annotation Group.  Then reannotate NH P Pref 
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Trouble Shooting Segment Annotation 

At times some segments may not annotate.  This could be due to a variety of reasons.  The NH P Pref annotation group was 
created using NHDOT Templates and Point names.  The points in a template may be different than those used to set up the 
preference or may not have the same point feature override names as those used.  Review your sections to figure out which 
segments are missing and review your template to see which points are on each end of the segment.  Select the template used 
when editing the entry. 

There may be different point names in the template that are not being used in the XS preference that labels the slopes.  In the 
delivered templates DM-0-12-4… the toe has a feature name override… P_TOE_L or R… and the slope break is P_SLP_B_L or 
R.  Ditch is P_DITCH_F_L or R.  Review the template for these names.  Point with overrides are shown in Red in the list. 

One cause of the segment not annotating may be a 0 offset between adjacent points.  When 2 points are at the same spot, the 
computer can get confused on which point to use when looking left to right to find the segments.  Adding a 0.002 foot offset 
between points (in the template or with a constraint) may help the annotation find a solution. 

 

The entries for XS Left (& Right) Slope Annotation can be copied.  
Open the XS Right Slope Annotation1 (the copy) and remove all the 
segments then add only the ones having trouble. It's possible 
something is conflicting with another entry…. XS Right Slope 
Annotation 1 Would look like this with just a few entries.  

 

In the original XS Left (& Right) Slope Annotation remove any entries 
for the segments used in the copy so you don’t have double 
annotations. 

 

 

 

 

 

 


